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Introduction 
 
Enabling LDAP Authentication for the CSA MC can have several benefits. These 
can include promoting single sign-on, reducing the amount of “static” administrative 
accounts in your environment where the passwords never change, and bringing your 
CSA administrator accounts under compliance with your security policies on 
passwords. 
 
This document is intended to show the steps involved in configuring the CSA MC to 
authenticate MC users through an external LDAP server/directory. Specifically, an 
Active Directory domain controller will be used as the LDAP server in all examples.  
 
This document is not intended to be an in depth resource for LDAP directories but 
rather to convey enough information to the CSA administrator that they can 
successfully configure LDAP authentication. The persons responsible for your 
company’s directory systems should always be consulted with before implementing 
in a production environment. 

New Features in 5.2.0.245 

Cisco introduced several new features to LDAP authentication in version 5.2.0.245. 
The MC now supports secure communication between the MC and the LDAP 
server, multiple directories on the same LDAP server, directory searching, and 
restricting logins to a specific group. Administrators are highly encouraged to 
upgrade to 5.2.0.245 or higher in order to take advantage of these features.  

Upgrade Note 
If an MC has been configured to use LDAP authentication in a prior version, once 
the MC is upgraded to 5.2.0.245 (or higher) the LDAP authentication will be brought 
over intact and functional. The administrator may want to edit the configuration to 
take advantage of the new features. 

CSA MC Login Configuration 
To enable LDAP authentication the option in the MC must enabled and configured. 
Local CSA MC administrator accounts will still function after LDAP authentication is 
enabled and the administrator will be able to choose from the login page which 
authentication source they wish to use before they login. 
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Enabling LDAP 
1. Begin the configuration process by logging in to the CSA MC as an 

administrator with configure rights 
2. From the Maintenance  menu select Login Configuration  
 

 
 

3. Place a check in the Use LDAP server for CSA MC authentication  box 
4. The configuration fields are now editable 
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LDAP Server 
For the Server  field, the fully qualified domain name (FQDN) of the LDAP server 
that contains the user accounts should be entered. The field will accept the FQDN 
alone as well as the FQDN preceded by the text ldap:// . 
 
Active Directory 
For environments using Microsoft Active Directory (AD), a level of fault tolerance can 
be achieved by entering in the domain name instead of a specific domain controller 
(DC). All DC’s in the specified domain will have the same user account information 
in the directory. Also, all domain controllers will have a DNS record that resolves 
their IP address to the domain name.  
 
By using the domain name instead of a specific DC you will ensure that: 

·  CSA LDAP authentication will still be able to function in case a specific 
DC is offline 

·  As DC’s are renamed, decommissioned, or brought online you will not 
have to make changes to your configuration in CSA (as long as the 
domain name in your environment remains the same; it would be very 
unlikely that this would change) 

·  Your AD administrators will be in a better position to perform 
maintenance on the DC’s (AD is fault tolerant by design, if production 
applications are tied to specific DC’s then the flexibility of the system is 
diminished) 

Example 
Active Directory Domain: priveontraining.com 
Domain Controllers:  

·  Dc01.priveontraining.com 
·  Dc02.priveontraining.com 
·  Dc03.priveontraining.com 

Instead of using a specific server and entering ldap://dc01.priveontraining.com  in 
the Server  field of the LDAP Configuration  window, you would enter in the name of 
the domain in the field such as ldap://priveontraining.com . 
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Other LDAP Servers 
For environments using other LDAP servers the premise is the same if supported by 
the environment. If there are multiple LDAP servers sharing the same directory and 
there is a single FQDN that will target the multiple LDAP servers then most likely this 
will be preferred over using a specific FQDN for a single server for similar reasons 
as those listed with using AD. Check with the administrators of your LDAP directory 
servers and perform your own testing to ensure this configuration will be successful 
in your environment. 

SSL 
By default, all communication between the CSA MC and the LDAP server is 
unencrypted. In order to use secure LDAP communication, the LDAP servers must 
have certificates installed and the CSA MC server must trust the CA (Certificate 
Authority) that signed the certificates. Once that prerequisite is in place, the Use 
SSL checkbox can be enabled. Refer to the Troubleshooting section in this 
document for the location of the log file that may help in troubleshooting binding to a 
secure connection. The installation and configuration of certificates and CA’s are 
outside the scope of this document. 

 Tip:  It is highly recommended to configure all other settings first and test for 
successful LDAP authentication before attempting to enable SSL. 
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Base DNs 
The Base DNs pane is used to specify the paths in your directory to use for finding 
users. If this is the first time LDAP has been configured on the MC there will be a 
default entry with a User Prefix of uid=  and a Base DN of dc=com . Delete this entry 
before continuing by selecting the entry and clicking the Delete button. 

 

User Prefix 
The User  Prefix  field is asking for the attribute used in your directory to define the 
RDN (Relative Distinguished Name) of a user account. During the login process the 
CSA MC will take the input from the user name field of the login screen and pair that 
with the entry in the User  Prefix  field to get the RDN of the user account. That will 
then be appended to the entry in the Base DN field to determine the DN of the user 
account.  
 
Example 
When using AD it is the Common Name (CN)  attribute of the user account that is 
used to authenticate the user to the CSA MC. In this scenario the text to enter in the 
Prefix  field would be CN= . The CN is an RDN in this example. 
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Base DN 
The Base DN field is the distinguished name  (DN) of the path inside the directory 
to where the user accounts exist that need to authenticate. A DN is a tree-like 
hierarchy of relative distinguished names  (RDN’s) and is used to uniquely identify 
a single entry in the directory. 
 
The configuration for the Base DN entry depends on whether the CSA MC itself will 
authenticate to the directory. If the MC is not configured to authenticate then it can 
not perform searches and the exact DN’s must be specified for the containers that 
hold the user accounts. If the MC is allowed to authenticate to the directory, then a 
high level search path may be specified and the MC will search the directory for the 
user account. Both methods will be explained and examples shown. 

Base DN – No MC Authentication to the Directory 
 

 It is important to note  that this DN must be the exact location (the container or 
OU) of all the user accounts that will be used for logging into the MC through 
LDAP. It is not a search path and the CSA MC login process will not descend 
into the directory structure below the DN path you specify. 

 
 
Example: 
In this scenario, the domain name is PriveonTraining.com. The user accounts I want 
to use to authenticate to the CSA MC are located in an OU named CSAadmins that 
is in the root of the directory. The DN of that OU would be 
OU=CSAadmins,DC=PriveonTraining,DC=com  . The entry I would make in the 
Base DN field would be the exact path of the DN as shown above, 
OU=CSAadmins,DC=PriveonTraining,DC=com  . 
Please note that the DN is case sensitive. 
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Using the above scenario, if there was a ServerAdmins  OU beneath the 
CSAadmins  OU that contained users that needed to login to the MC via LDAP then 
the login process would not be successful for them. This is because the Base DN 
field is looking in OU=CSAadmins,DC=PriveonTraining,DC=com  not 
OU=ServerAdmins,OU=CSAadmins,DC=PriveonTraining,DC= com   
 
By default, in an environment using Microsoft AD, all user accounts are stored in the 
Users container in the root of the directory. To use the Users container as your DN 
then your entry in the Usersroot  field would be 
CN=Users,DC=PriveonTraining,DC=com  . 

Using Multiple Base DN’s 
It is possible to enter multiple entries in the Base DNs  field. The MC will then try to 
authenticate the user with each of the entries you specify in the order shown on 
screen until it successfully finds the user or reaches the last DN entry and fails. 
 
This can be used in situations where there are multiple directories hosted on the 
same LDAP server or if there are several OU’s that contain users that need to be 
authenticated. In this configuration, the DN for every OU that contains a user that 
needs to be authenticated to the MC must be entered. When using a single 
directory, multiple Base DN’s should only be necessary when the MC is not 
authenticating to the directory. 
 



  

PriveonLabs Research 
Cisco Security Agent Protection Series:  Enabling LDAP for 
CSA Management Center SSO authentication. 

 

 

  
www.priveon.com 

Page 9 of 23 

Tip:  In environments with 
large directories, 
searching from the root 
of the directory may 
result in slow response 
times. Better 
performance will be 
experienced if a small 
number of Base DN’s are 
entered that will limit the 
paths that are searched 
in the directory. 
 
For example:  If all user 
accounts in the directory 
are within 3 root level 
OU’s but the directory 
has 25 root level OU’s, 
performance may be 
increased by specifying 
the Base DN of the three 
containing users instead 
of the root of the 
directory itself. 

Base DN –MC Authenticates to the Directory 
User accounts can exist in various places within the directory. Specifying the exact 
DN for the location of all the accounts you wish to login to the MC can be very 
tedious and in some cases, impractical.  
 
The solution is to utilize the LDAP User Search Mode  feature in the MC. This 
allows the administrator to specify a user account that the CSA MC can use to 
authenticate itself to the directory. Once it has been authenticated, it can perform 
searches for a username starting at a top level DN. This removes the need to 
specify several DN’s in the Base DNs field. 

 
 
Example: 
In this scenario, the domain name is PriveonTraining.com. The user accounts I want 
to use to authenticate to the CSA MC are located in an OU named CSAadmins that 
is in the root of the directory. Previously, the full DN of that OU would have been 
required in the Base DN field. Using the LDAP User Search Mode allows me to 
specify the root of the directory as the only entry. The entry I would make in the 
Base DN field would be DC=PriveonTraining,DC=com . The MC will start at this 
DN and search recursively for the user account. 
Please note that the DN is case sensitive. 
 
Using the above scenario, any user account that existed in the directory would be 
able to successfully login to the MC no matter what OU or container they existed in 
(assuming the CSA administrator created a CSA login for them first & the user account the MC used for authenticating to the 
directory had read privileges on the appropriate containers).  
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LDAP User Search Mode 
As mentioned previously, this feature enables the MC to search recursively through 
the directory for a user account using a single top level DN as the starting point for 
the search.  

LDAP Authentication User Account 
The user account that is utilized for this feature should be a new dedicated account 
used specifically for this purpose. The user account must be in the same directory 
that you will be searching. The account itself does not need any special permissions 
or elevated privileges. The account simply needs read permissions to the containers 
and OU’s in the directory that contain user accounts. No changes or writes to the 
directory will be made. By default, a new user account in AD environments will have 
the necessary read permissions without any further changes required. 

User DN 
The value of the User DN field should be the full DN of the user account you have 
created for this purpose.  Enter the password for the account in the Password field. 

 
 

Example: 
In this scenario we are using an account with a CN of CSA LDAP  that is inside an 
OU in the root of the directory, named Accts . The value of the User DN field should 
be CN=CSA LDAP,OU=Accts,DC=PriveonTraining,DC=com . 
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Group Restriction 
The Group Restriction setting is an optional feature that allows the CSA 
administrator to further limit who can authenticate to the CSA MC via LDAP.  
Specifically the Group Restriction option configures the MC so that even if a CSA 
Administrator user account is correctly configured to use LDAP authentication, 
unless it is also  a member of the group specified in the Group Restriction option, the 
user will not be able to authenticate. 

Attribute 
The Attribute  field is used to determine whether the user trying to authenticate via 
LDAP is a member of the group specified in the Group DN field.  The value of the 
field is the actual attribute name in the directory that contains the group 
memberships for a user account. 

Group DN 
The value of the Group DN  field is the full Distinguished Name of the group in the 
directory whose members are allowed to authenticate to the MC via LDAP. 
 

 

Example 
In this scenario using Active Directory, the attribute of a user account that contains 
information on which groups the user account is a member of is memberof  . A 
group named CSA LDAP Admins has been created in an OU in the root of the 
directory, named Accts . The value of the Group DN  field should be CN=CSA LDAP 
Admins,OU=Accts,DC=PriveonTraining,DC=com . Any user account that will 
authenticate to the MC via LDAP must now be a member of that group. 
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Creating a CSA MC Administrator Account 
For a user to be authenticated to the CSA MC via LDAP, there must be an account 
created in the MC with a Login Name  that matches the RDN (the value of the CN 
attribute in this scenario) of the user account in the directory. Do not assign the 
account a password. This will be the difference between accounts that authenticate 
locally to the CSA MC (a password is assigned to the account) and those that will 
authenticate via LDAP (no password is assigned to the account).  
 
Example   
The user we want to use for LDAP authentication in this scenario is Tom Bombadil. 
The properties of Tom’s user account are as follows: 

·  First Name: Tom 
·  Last Name: Bombadil 
·  Display Name: Tom Bombadil 
·  User logon name: tbombadil 
·  CN: Tom Bombadil 
·  DN: CN=Tom Bombadil,OU=CSAadmins,DC=PriveonTraining,DC=com 

 
Based on the account information above then the Login Name  of the account we 
will create in the CSA MC will be Tom Bombadil . 
 

 
 

 It is important to note  that Tom may log into AD everyday using tbombadil  
(the sAMAccountName attribute of the account), but in order to login to CSA via 
LDAP, he will have to use the value of the CN attribute of his account (Tom 
Bombadil ). 
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Logging in to the CSA MC via LDAP 
Now that we have authentication configured and Tom’s login created in the MC he 
can start logging in. At the CSA MC login screen there will now be an 
Authentication  drop down menu. 

 
 

That has the choices LDAP and Local  for administrators to choose which type of 
account they wish to authenticate to the MC with. The Username  field is case 
sensitive, so tom bombadil will not succeed. 
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Using Tom Bombadil  will succeed. 
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Conclusion 
Using the information above, we have configured the CSA MC to communicate with 
an LDAP server, defined multiple query paths, enabled directory searching, created 
a CSA administrator for Tom that maps to his AD account, and gotten Tom logged in 
successfully. All directory systems are different, so some changes to the instructions 
given may be necessary, but this will give the CSA administrator a basic knowledge 
of the process in order to successfully implement in their own environment. 

 

Additional Resources 
For more information including screenshots, useful software tools, troubleshooting 
tips, and how to gather information from your LDAP directory, please see the 
appendices. 
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Appendix A  

Getting LDAP Values from Active Directory 
One part of the configuration process that many CSA administrators may find 
particularly difficult, is actually determining what LDAP values to input to CSA. This 
section will give some examples of how to obtain the values needed to complete the 
setup process for CSA LDAP authentication. Please note that the examples given 
here are only one of many ways to obtain the information needed. 
 

Domain for LDAP Server Field 
If the name of the domain that contains the user accounts you wish to use for 
authentication is not immediately known, then the following is a way to determine 
that information and more.  
 
You will need to have the Windows Server 2003 Administration Tools Pack  
installed on your workstation in order to continue. In most environments you will not 
need any special user permissions in order to obtain any of the information needed. 
 

·  Open Active Directory Users & Computers  
·  You should see the name of your domain in the top of the tree. 
 

 
 

·  The domain name should be used as the value for LDAP Server field in the 
CSA MC to promote redundancy 

·  If for some reason a specific Domain Controller must be used then you can 
determine the available DC’s by browsing to the Domain Controllers  
container in the tree list. 
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DN for Base DN Field & RDN for User Prefix Field 
To obtain the exact DN required with all the correct syntax and capitalization you 
can use a free tool from the Windows Support Tools  named ldp.exe . Ldp.exe is a 
GUI browser for navigating through an LDAP directory & it will be one of the tools 
used to obtain the information from AD for CSA. You can install the support tools 
from your Windows installation CD-ROM or download the latest version from 
Microsoft (http://support.microsoft.com/kb/892777).  
 
Many directories are very large and knowing exactly where a user account exists in 
the tree structure can be difficult. Using the Active Directory Users & Computers  
tool to search the directory for the user account and then using ldp.exe  to obtain the 
information needed can help. 

·  Open Active Directory Users & Computers  
·  Ensure that you are using the Advanced Features from the View menu 
·  Use the Find  action to search for the user account you wish to know the DN 

for 
·  Once you’ve found the user, go to the properties of the user 
 

o On the General tab note the Display Name of the user 
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o On the Account tab note the User logon name of the user 
 

 
 

o On the Object tab note the Canonical name of object of the user 

 
 

The Display name value will be the value of the CN in most environments. This may 
not be the same value as the User logon name. The Canonical name of object 
shows the domain the account is in and then what OU’s or containers the account is 
in. In our example Tom’s account is in the PriveonTraining.com domain and in the 
CSAadmins OU. 
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Now that we have determined what OU the user account is in we need to verify the 
correct syntax for the DN using ldp.exe 

·  Open the ldp.exe  tool 
·  On the Connection menu choose the Connect  entry, type in the FQDN of 

your domain and click OK 
·  Now perform a  Bind  operation by choosing the Bind  entry from the 

Connection  menu, typing in a valid username and password that has at least 
read rights to your directory, the NTLM name of your domain, and clicking OK 

·  Once you have successfully authenticated to the directory you should see 
output on the right pane of the screen 

·  Look for the entry that says defaultNamingContext:   
·  The text that follows is the DN of your domain and will be used as the base 

DN in your searching 
·  In our example the entry is  

o defaultNamingContext: DC=PriveonTraining,DC=com 
·  Switch to Tree view mode by clicking the View menu and selecting the Tree 

menu item 
·  Enter the DN of your domain obtained in the previous step such as 

DC=PriveonTraining,DC=com 
·  You will now be able to navigate through your directory and find the user 

account in the OU shown in the Canonical name of object  field from the 
user account properties screen earlier 

·  Upon finding the user account double-click its entry to query the directory as 
to its attributes and view the output in the right window pane 

·  The DN of the user account is shown on a line similar to  
o >> Dn: CN=Tom Bombadil,OU=CSAadmins,DC=PriveonTrain ing,DC=com 
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From this we can determine that the DN (Distinguished Name) of the OU or 
container that holds the user account is OU=CSAadmins,DC=PriveonTraining,DC=com  
and that is also the exact text we need to enter in the Base DN field (assuming we are not 

enabling LDAP User Search Mode, in that case the Base DN value would be DC=PriveonTraining,DC=com). 
 
We also now know that CN is the Relative Distinguished Name  used to identify the 
user account in the directory and that we should enter CN in the Prefix  field. 
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Troubleshooting 
 

CSA MC Log 
If you experience any issues with logging in to your CSA MC after setting up LDAP 
authentication you should check your csamclog.txt  log file. The log file is located in 
the <Drive Letter>:\Program Files\Cisco Systems\CSAMC\C SAMC52\log  
directory. The log file will not be overly verbose but it will give you the DN that it is 
sending in its request to the directory. This will allow you to troubleshoot and see if 
that DN is valid or not. 

Example 
I have correctly configured the values in my CSA MC login configuration page but 
Tom says he still can not login. I open my csamclog.txt file and see the following 
entry: 
ldap simple bind failed, error code 31, dn = CN=tbo mbadil,OU=CSAadmins,DC=PriveonTraining,DC=com 

 
The log file has given me the exact LDAP path it is trying to use to find that user. I 
can utilize ldp.exe to browse or search that path to see if the object exists or whether 
the path or syntax is incorrect. 
 
After doing so I realize that Tom is not logging into the CSAMC with a username that 
is part of the DN on his user account. He is trying to login with his AD User login 
name (This maps to the sAMAccountName  attribute in the directory, not the CN 
attribute) not the value of his CN which is Tom Bombadil . 

SSL Error Example 
When troubleshooting SSL communication it can be helpful to check the 
csamclog.txt file for the following error.  
 
Initializing secure ldap conection for authenticati on 
ldap_connect failed, error code 51, dn =  One of th e possible reason can be invalid certificates  
 

This is most likely caused by either the CSA MC server not trusting the Certificate 
Authority that signed the certificates used by the LDAP servers or the LDAP servers 
do not have certificates installed on them.
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Appendix B 

Links 
Here are links to some resources that may be useful in learning more about LDAP 
directories as well as some of the tools used in the configuration process described 
in this document. 

·  Windows Server 2003 R2 Administration Tools Pack (A D users and 
Computers) 

o https://www.microsoft.com/downloads/details.aspx?familyid=9BFB44F5-232A-4FB5-BC14-
45BFD81B7AC1&displaylang=en 

·  Windows Server 2003 Service Pack 1 Support Tools (l dp.exe) 
o http://support.microsoft.com/kb/892777 

·  Windows Server 2003 - LDP Support Tool Utility Tuto rial 
o http://www.computerperformance.co.uk/w2k3/utilities/ldp.htm 

·  Understanding directories - IBM 
o http://publib.boulder.ibm.com/infocenter/hodhelp/v9r0/topic/com.ibm.hod9.doc/help/ldapintro.html 

·  LDAP Query Basics (Microsoft) 
o http://technet.microsoft.com/en-us/library/aa996205.aspx 

·  Using Ldp.exe to Find Data in the Active Directory (Microsoft) 
o http://support.microsoft.com/kb/224543 
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Where to Go for More Information: 
 
 

Custom Research Documents 
Exploit Reverse 

Engineering/Forensics 
Security Implementation 

Real-World Training 
Managed Services 
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